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A bonus 2-hour set of Adobe Premiere Pro 
CS6: Learn by Video tutorials are included, 
from video2brain and Adobe Press. Learn 
by Video is one of the most critically 
acclaimed training products on Adobe 
software and is the only Adobe-approved 
video courseware for the Adobe Certified 
Associate Level certification.

Learn by Video 
bonus tutorials

Lesson files

Links to Adobe Community 
Help, product Help and 
Support pages, Adobe 
Press, Adobe certification 
programs, Adobe TV, and 
other useful online resources 
can be found inside a handy 
HTML file. Just open it in 
your Web browser and click 
on the links, including a 
special link to this book’s 
product page where you can 
access updates and bonus 
material.
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Online resources

Throughout this title you will see references to lesson or resource files on a disc. 
Please note that these files are available to eBook readers via high-speed download. 
Please click here to go to the last page in this eBook for the download location and 
instructions. 

Adobe Premiere Pro CS6 Classroom in a Book includes the lesson files that you’ll 
need to complete the exercises in this book, as well as other content to help you 
learn more about Adobe Premiere Pro CS6 and use it with greater efficiency and 
ease. The diagram below represents the contents of the lesson files directory, which 
should help you locate the files you need.

EBOOK READERS: FIND YOUR LESSON FILES

Each lesson has its own folder 
inside the Lessons folder. You 
will need to download these 
lesson folders to your hard 
drive before you can begin 
each lesson.

AVAILABLE VIA DOWNLOAD
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Adobe® Premiere® Pro CS6, the essential editing tool for video enthusiasts and 
professionals, enhances your creative power and freedom. Adobe Premiere Pro 
is the most scalable, efficient, and precise video-editing tool available. It sup-
ports a broad range of video formats including AVCHD, HDV, XDCAM, P2 
DVCPRO HD, XDCAM, AVC-Intra, Canon XF, RED, ARRIRAW, QuickTime, 
and many more. The superior performance of Adobe Premiere Pro lets you 
work faster and more creatively. The complete set of powerful and exclusive 
tools lets you overcome any editorial, production, and workflow challenges to 
deliver the high-quality work you demand.

About Classroom in a Book
Adobe Premiere Pro CS6 Classroom in a Book® is part of the official training 
series for Adobe graphics and publishing software. The lessons are designed 
so that you can learn at your own pace. If you’re new to Adobe Premiere Pro, 
you’ll learn the fundamental concepts and features you’ll need to use the 
program. This book also teaches many advanced features, including tips and 
techniques for using the latest version of this software.

The lessons in this edition include opportunities to use features such as mul-
ticamera editing, keying, dynamic trimming, color correction, tapeless media, 
and audio and video effects. You’ll also learn how to create files for the Internet 
and mobile devices with Adobe Media Encoder or send a sequence to Adobe 
Encore CS6 without rendering or intermediate exporting to output to DVD, 
Blu-ray Disc, or Adobe Flash. Performance has been significantly enhanced 
with the new Mercury Playback Engine, which provides both software- and 
hardware-assisted performance breakthroughs. Adobe Premiere Pro CS6 is 
available for both Windows and Mac OS.

Getting Started
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Prerequisites
Before beginning to use Adobe Premiere Pro CS6 Classroom in a Book, make sure 
your system is set up correctly and that you’ve installed the required software and 
hardware. You can view updated system requirements by visiting www.adobe.com/
products/premiere/tech-specs.html.

You should have a working knowledge of your computer and operating system. You 
should know how to use the mouse and standard menus and commands and also 
how to open, save, and close files. If you need to review these techniques, see the 
printed or online documentation included with your Windows or Mac OS system.

Installing Adobe Premiere Pro CS6
You must purchase the Adobe Premiere Pro CS6 software separately from this 
book. It can be purchased as a stand-alone product or included in the Creative 
Suite or Creative Cloud families. Install Adobe Premiere Pro from the software 
DVD onto your hard disk; you cannot run the program from the DVD. If you pur-
chased a downloadable version, follow the instructions included with the download 
for launching the installation process.

Adobe Premiere Pro CS6 trial
Adobe offers a 30-day trial of Adobe Premiere Pro CS6. You can download this trial 
from the Adobe product website. After 30 days, the software will stop functioning. 
If you decide to purchase Adobe Premiere Pro, you can enter your purchased serial 
number into the trial version you have installed to convert it to a full version of 
Adobe Premiere Pro CS6.

Optimizing performance
Editing video is memory- and processor-intensive work for a computer. A fast 
processor and a lot of memory will make your editing experience much faster and 
more efficient; 4 GB of memory is the minimum, and 8 GB or more is better for 
high-definition (HD) media. Adobe Premiere Pro CS6 takes advantage of multicore 
processors on Windows and Macintosh systems.

www.adobe.com/products/premiere/tech-specs.html
www.adobe.com/products/premiere/tech-specs.html
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A dedicated 7200 RPM or faster hard drive is recommended for high-definition 
video (HD) media. A RAID 0 striped disk array or SCSI disk subsystem is strongly 
recommended for HD. Performance will be significantly affected if you attempt to 
store media files and program files on the same hard drive. Be sure to keep your 
media files on a second disk if at all possible.

The Mercury Playback Engine in Adobe Premiere Pro can operate in software-
only mode or GPU acceleration mode. The GPU acceleration mode provides 
significant performance improvement. The GPU acceleration is possible with 
select video cards. You can find a list of these video cards on the Adobe website 
at www.adobe.com/products/premiere/tech-specs.html.

Copying the lesson files
The lessons in Adobe Premiere Pro CS6 Classroom in a Book use specific source 
files, such as video clips, audio files, and image files created in Adobe Photoshop 
CS6 and Adobe Illustrator CS6. To complete the lessons in this book, you must 
copy all the files from the Adobe Premiere Pro CS6 Classroom in a Book DVD 
(inside the back cover of this book) to your hard drive. You will need about 4 GB of 
storage space in addition to the 4 GB you need to install Adobe Premiere Pro CS6.

Although each lesson stands alone, some lessons use files from other lessons, so 
you’ll need to keep the entire collection of lesson assets on your hard drive as you 
work through the book. Here’s how to copy those assets from the DVD to your 
hard drive:

1	 Open the Adobe Premiere Pro CS6 Classroom in a Book DVD in My Computer 
or Windows Explorer (Windows) or in Finder (Mac OS).

2	 Right-click (Windows) or Control+click (Mac OS; if you’re using a super mouse 
or pen, you can right-click) the folder called Lessons, and choose Copy.

3	 Navigate to the location you set to store your Adobe Premiere Pro CS6 projects.

The default location is My Documents\Adobe\Premiere Pro\6.0 (Windows) or 
Documents/Adobe/Premiere Pro/6.0 (Mac OS).

4	 Right-click (Windows) or Control+click (Mac OS) inside the 6.0 folder, and 
choose Paste.

Following these steps will copy all the lesson assets to your local folder. This 
process may take a few minutes to complete, depending on the speed of your 
hardware.

www.adobe.com/products/premiere/tech-specs.html
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Relinking the lesson files
It is possible that the file path to the lesson files may need to be updated. If you 
open an Adobe Premiere Pro project and it cannot find a media file, a dialog may 
open and ask you “Where is the File MEDIA.mov’?” If this happens, you will need 
to navigate to one of the offline files in order to reconnect. Once you’ve recon-
nected one file in the project, the rest should reconnect.

•	 You can navigate to the same location where you copied the files you copied 
from the DVD. The path will be Premiere Pro CS6 CIB > Lessons > Assets. 
You may need to look in some of the included folders to find the media file 
(especially if it involves tapeless media).

•	 You can use the search field in the OS dialog box to search for the file by name.

When you locate a file, just select it and click the Open button.

How to use these lessons
Each lesson in this book provides step-by-step instructions for creating one or 
more specific elements of a real-world project. The lessons stand alone, but most of 
them build on previous lessons in terms of concepts and skills. So, the best way to 
learn from this book is to proceed through the lessons in sequential order.

The organization of the lessons is workflow-oriented rather than feature-oriented, 
and the book uses a real-world approach. The lessons follow the typical sequential 
steps video editors use to complete a project, starting with acquiring video, laying 
down a cuts-only sequence, adding effects, sweetening the audio track, and ulti-
mately exporting the project to the Web, a portable device, a DVD, a Blu-ray Disc, 
or Flash.

Additional resources
Adobe Premiere Pro CS6 Classroom in a Book is not meant to replace documenta-
tion that comes with the program or to be a comprehensive reference for every 
feature. Only the commands and options used in the lessons are explained in this 
book. For comprehensive information about program features and tutorials, please 
refer to these resources:

Adobe Community Help: Community Help brings together active Adobe product 
users, Adobe product team members, authors, and experts to give you the most 
useful, relevant, and up-to-date information about Adobe products.
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To Access Community Help: To invoke Help, press F1 or choose Help > Premiere 
Pro Help.

Adobe content is updated based on community feedback and contributions. You can 
add comments to content and forums (including links to web content), publish your 
own content using Community Publishing, or contribute Cookbook recipes. Find 
out how to contribute at www.adobe.com/community/publishing/download.html.

See community.adobe.com/help/profile/faq.html for answers to frequently asked 
questions about Community Help.

Adobe Premiere Pro CS6 Help and Support: www.adobe.com/support/premiere 
is where you can find and browse Help and Support content on adobe.com.

Adobe Forums: forums.adobe.com lets you tap into peer-to-peer discussions, 
questions, and answers on Adobe products.

Adobe TV: tv.adobe.com is an online video resource for expert instruction and 
inspiration about Adobe products, including a How To channel to get you started 
with your product.

Adobe Design Center: www.adobe.com/designcenter offers thoughtful articles 
on design and design issues, a gallery showcasing the work of top-notch designers, 
tutorials, and more.

Adobe Developer Connection: www.adobe.com/devnet is your source for techni-
cal articles, code samples, and how-to videos that cover Adobe developer products 
and technologies.

Resources for educators: www.adobe.com/education offers a treasure trove of 
information for instructors who teach classes on Adobe software. Find solutions 
for education at all levels, including free curricula that use an integrated approach 
to teaching Adobe software and can be used to prepare for the Adobe Certified 
Associate exams.

Also check out these useful links:

Adobe Marketplace & Exchange: www.adobe.com/cfusion/exchange is a central 
resource for finding tools, services, extensions, code samples, and more to supple-
ment and extend your Adobe products.

Adobe Premiere Pro CS6 product home page: www.adobe.com/products/premiere

Adobe Labs: labs.adobe.com gives you access to early builds of cutting-edge 
technology, as well as forums where you can interact both with the Adobe develop-
ment teams building that technology and with other like-minded members of the 
community.

www.adobe.com/community/publishing/download.html
www.adobe.com/support/premiere
www.adobe.com/designcenter
www.adobe.com/devnet
www.adobe.com/education
www.adobe.com/cfusion/exchange
www.adobe.com/products/premiere
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Adobe certification
The Adobe training and certification programs are designed to help Adobe custom-
ers improve and promote their product-proficiency skills. There are four levels of 
certification:

•	 Adobe Certified Associate (ACA)

•	 Adobe Certified Expert (ACE)

•	 Adobe Certified Instructor (ACI)

•	 Adobe Authorized Training Center (AATC)

The Adobe Certified Associate (ACA) credential certifies that individuals have the 
entry-level skills to plan, design, build, and maintain effective communications 
using different forms of digital media.

The Adobe Certified Expert program is a way for expert users to upgrade their 
credentials. You can use Adobe certification as a catalyst for getting a raise, finding 
a job, or promoting your expertise.

If you are an ACE-level instructor, the Adobe Certified Instructor program 
takes your skills to the next level and gives you access to a wide range of Adobe 
resources.

Adobe Authorized Training Centers offer instructor-led courses and training 
on Adobe products, employing only Adobe Certified Instructors. A directory of 
AATCs is available at partners.adobe.com.

For information on the Adobe Certified programs, visit www.adobe.com/support/
certification/index.html.

Checking for updates
Adobe periodically provides updates to software. You can easily obtain these 
updates through Adobe Updater, as long as you have an active Internet connection.

1	 In Premiere Pro, choose Help > Updates. Adobe Updater automatically checks 
for updates available for your Adobe software.

2	 In the Adobe Updater dialog box, select the updates you want to install, and 
then click Download and Install Updates to install them.

For book updates and bonus material, visit the book’s page on the Web at 
www.peachpit.com/prcs6cib.

www.adobe.com/support/certification/index.html
www.adobe.com/support/certification/index.html
www.peachpit.com/prcs6cib
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Organizing Media

Lesson Overview
In this lesson, you’ll learn about the following:

•	 Using the Project panel

•	 Staying organized with bins

•	 Adding metadata to your clips

•	 Using essential playback controls

•	 Interpreting footage

•	 Making changes to your clips

This lesson will take approximately 50 minutes.

4
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Once you have some video and sound assets in your 
project, you’ll want to get on with looking through 
your footage and adding clips to a sequence. Before 
you do, it’s well worth spending a little time organiz-
ing the assets you have. Doing so can save you hours 
of hunting for things later.
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Getting started
When you have lots of clips in your project, imported from several different media 
types, it can be a challenge to stay on top of everything and always find that magic 
shot when you need it.

In this lesson, you’ll learn how to organize your clips using the Project panel, which 
is the heart of your project. You’ll create special folders, called bins, to divide your 
clips into categories. You’ll also learn about adding important metadata and labels to 
your clips.

You’ll begin by getting to know the Project panel and organizing your clips.

Before you begin, make sure you are using the default Editing workspace.

1	 Click Window > Workspace > Editing.

2	 Click Window > Workspace > Reset Current Workspace.

3	 Click Yes in the Reset Workspace dialog.

For this lesson, you’ll use the project file you used in Lesson 3.

4	 Continue to work with the project file from the previous lesson, or open it from 
your hard drive.

5	 Choose File > Save As.

6	 Rename the file to Lesson 04.prproj.

7	 Choose a preferred location on your hard drive, and click Save to save the 
project.

If you do not have the previous lesson file, you can open the file Lesson 
04.prproj from the Lesson 04 folder.

The Project panel
Anything you import into your Adobe Premiere Pro CS6 project will appear in 
the Project panel. As well as giving you excellent tools for browsing your clips and 
working with their metadata, the Project panel has special folders, called bins, you 
can use to organize everything.

No matter how you import your clips, everything that appears in a sequence must 
appear in the Project panel. If you delete a clip in the Project panel that is already 
used in a sequence, the clip will automatically be removed from the sequence. Don’t 
worry, though, because Adobe Premiere Pro will warn you if you do this.
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Zoom Find New bin

Panel menuFilter bin content Headings

As well as acting as the repository for all of your clips, the Project panel gives you 
important options for interpreting media. All of your footage will have a frame rate 
and pixel aspect ratio, for example, and you may want to change these settings for 
creative reasons. You could, for example, interpret 30fps video as 24fps to achieve 
a subtle slow-motion effect. You might also receive a video file that has the wrong 
pixel aspect ratio setting.

Adobe Premiere Pro uses metadata associated with footage to know how to play it 
back. If you want to change the metadata, you can use the Project panel to do so.

It’s all too easy to leave things with names like “untitled” 
or “new.” Although this might work out fine with only 
two or three clips, how would you find anything with two 
or three hundred?

Even if your clips have individual names, as in the case of 
our current project, they may not be super clear or easy 
to identify.

Let’s look at some ways to get organized.
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Customizing the Project panel
It’s quite likely that you will want to resize the Project panel from time to time. 
You’ll be alternating between looking at your clips as a list or as thumbnails, and 
sometimes it’s quicker to resize the panel than scroll over to see more information.

The default Editing workspace is designed to keep the interface as clean as possible 
so you can focus on your creative work rather than the buttons. Part of the Project 
panel that’s hidden from view, called the Preview Area, gives additional informa-
tion about your clips.

Let’s take a look at it:

1	 Click the panel menu for the Project panel.

2	 Choose Preview Area.

The Preview Area 
shows you several 
kinds of useful 
information about a 
clip when you select 
it in the Project panel, 
including the frame 
size, pixel aspect ratio, 
and duration. 
 
 

Frame size

Audio type

Duration and 
frame rate

Play/Stop

Clip typeClip namePoster frame

If it is not already selected, click the List View button  at the bottom-left 
corner of the Project panel. In this view, a lot of information is available about 
each clip in the Project panel, but you need to scroll horizontally to see it.

The Preview Area gives you a mix of information about clips when you need it.

3	 Click the panel menu for the Project panel.

4	 Choose Preview Area to hide it.

E	Tip:  There’s a very 
quick way to toggle 
between seeing the 
Project panel in a frame 
and seeing it full-screen. 
Just press the ` (grave) 
key. You can do this 
with any panel in 
Adobe Premiere Pro.

P	Note:  Be sure to 
follow the instructions 
in the “Getting Started” 
section that begins this 
lesson.
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Finding assets in the Project panel
Working with clips is a little like working with pieces of paper at your desk. If you 
have just one or two clips, it’s easy. Once you have one or two hundred, you need a 
system!

One way you can help make things smoother during the edit is to take a little time 
to organize your clips at the very beginning. If you can name your clips during 
capture or after importing them, it can help enormously. Even if you don’t give each 
individual clip its own name during capture from tape, you can give a name to each 
type of shot and let Adobe Premiere Pro add 01, 02, 03, and so on (see Chapter 3, 
“Importing Metadata”).

E	Tip:  You can scroll the Project panel view up and down using the mouse wheel.

1	 Click the name heading at the top of the Project panel. The items in the Project 
panel are displayed in alphabetical order or reverse alphabetical order when you 
click the name heading.

2	 Scroll to the right until you can see the Media Duration heading in the Project 
panel. This shows the total duration of each clip’s media file.

3	 Click the Media Duration heading. Adobe Premiere Pro displays the clips in 
order of media duration. Notice the direction arrow on the Media Duration 
heading. When you click the heading, the direction arrow toggles between 
showing clips in duration order or reverse duration order.

P	Note:  You may need to click and drag to expand the width of a column to see its arrow.

If you’re looking for lots of clips with particular features—such as a duration or 
a frame size—it can be helpful to change the order in which the headings are 
displayed.

4	 Click and drag the Media Duration heading to the left, until you see a blue 
divider between the Label heading and the Name heading. When you release the 
mouse button, the Media Duration heading will be repositioned right next to the 
Name heading.

The blue divider shows where you will drop the heading.

P	Note:  When you 
scroll to the right in 
the Project panel, 
Adobe Premiere Pro 
always maintains the 
clip names on the left 
so you know which 
clips you’re seeing 
information about.

P	Note:  Graphic 
and photo files like 
Photoshop PSD, 
JPEG, or Illustrator AI 
files import with the 
duration you set in 
Preferences > General > 
Still Image Default 
Duration.
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Filter bin content

Adobe Premiere Pro has built-in search tools to help you find your media. Even if 
you are using the rather nondescriptive original clip names taken from a file-based 
camera, you can search for things like a frame size or a file type.

At the top of the Project panel, you can type in 
the Filter Bin Content box to display only clips 
that match the text you enter. This is a very 
quick and easy way of locating a clip if you remember what it is called. Clips that 
don’t match the text you enter are hidden and clips that do are revealed, even if they 
are inside a bin.

1	 Click into the Filter Bin Content box, and type the letters ser.

Adobe Premiere Pro displays only the clips with the letters ser in the name. 
Notice the name of the project is displayed above the text entry box, along with 
“(filtered).”

2	 Click the X on the right of the Filter Bin Content box to clear your filter.

3	 Type the letters psd in the box.

Adobe Premiere Pro displays only clips that have the letters psd in their name, along 
with all the project bins. In this case, it’s just one clip that was imported earlier. Using 
the Filter Bin Content box in this way, you can look for particular types of files.

To the left of the text entry box you should see a button menu that displays a list of 
recent entries, along with the number of clips that match the search criteria.

To the right of the Filter Bin Content box, there’s 
an In menu where you can specify whether Adobe 
Premiere Pro should search for clips based on all of 
the available metadata, just the metadata displayed 
currently (see “Working with bins” later in this chap-
ter), or words taken from scripts (see “Organizing media with content analysis” later 
in this chapter).

Usually, it isn’t necessary to choose anything in this menu because the filtering 
works when using the All option if you type selections carefully. Be sure to click 
the X on the right of the Filter Bin Content box to clear your filter.

P	Note:  The folders 
you create inside the 
Project panel are called 
bins. This is a term taken 
from film editing. The 
Project panel itself is 
effectively a bin, since 
you can contain clips 
inside it. It functions 
exactly like any other 
bin and is referred to 
as one.
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Find

Adobe Premiere Pro also has an advanced Find option. To learn about it, let’s 
import a couple of extra clips.

1	 Using any of the methods described in Lesson 3, import Seattle_Skyline.mov 
and Vegas_Night.mov from the Assets folder, included with these lessons.

2	 At the bottom of the Project panel, click the Find button . Adobe Premiere 
Pro displays the Find panel, which has more advanced options for locating 
your clips.

There are two sets of searches you can perform at the same time with the Adobe 
Premiere Pro Find panel. You can choose to display clips that match both search 
criteria or either search criteria. For example, you could do either of the following:

•	 Search for a clip with the words dog AND boat in its name.

•	 Search for a clip with the word dog OR boat in its name.

Then choose from the following options:

•	 Column: Selects from the available headings in the Project panel. When you 
click Find, Adobe Premiere Pro will search using only the heading you select.

•	 Operator: Gives you a set of standard search options. Use this menu to choose 
whether you want to find a clip that contains, matches exactly, begins with, or 
ends with whatever you search for.

•	 Match: Choose All to find a clip with both your first and second search text. 
Choose Any to find a clip with either your first or your second search text.

•	 Case Sensitive: Tells Adobe Premiere Pro whether you want your search to 
exactly match the upper- and lowercase letters you enter.

•	 Find What: Type your search text here. You can add up to two sets of 
search text.

When you click Find, Adobe Premiere Pro highlights a clip that matches your search 
criteria. Click Find again, and Adobe Premiere Pro highlights the next clip that 
matches your search criteria. Click Done to exit the Find dialog box.
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Working with bins
Bins have the same icon as a folder on your hard drive and work in almost exactly 
the same way. They allow you to store your clips in a more organized way, by divid-
ing them into different groups.

Just like folders on your hard drive, you can have multiple bins inside other bins, 
creating a folder structure as comprehensive as your project requires.

There’s one very important difference between bins and folders on your hard drive: 
Bins exist only inside your Adobe Premiere Pro project file. You won’t see individual 
project bins anywhere on your hard drive.

Creating bins
Let’s create a bin.

1	 Click the New Bin button at the bottom of the Project panel.

Adobe Premiere Pro creates a new bin and automatically 
highlights the name, ready for you to rename it. It’s a good idea 
to get into the habit of naming bins when you create them.

2	 We have some clips from a film, so let’s give them a bin. Name the bin Double 
Identity.

3	 You can also create a bin using the File menu. Choose File > New > Bin.

4	 Name this bin PSD files.

5	 You can also make a new bin by right-clicking a blank area in the Project panel 
and choosing New Bin. Try this now.

6	 Name the new bin Illustrator files.

One of the quickest and easiest ways to create a new bin for clips you already 
have in your project is to drag and drop the clips onto the New Bin button at the 
bottom of the Project panel.

7	 Drag and drop the clip Vegas_Night.mov onto the New Bin button.

8	 Name the bin City Views.

P	Note:  It can be quite 
difficult to find a blank 
part of the Project panel 
to click when it is full of 
clips. Try clicking just 
to the left of the icons, 
inside the panel.
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9	 Press the keyboard shortcut Control+/ (Windows) or Command+/ (Mac) to 
make a new bin.

10	Name the bin Sequences.

If your Project panel is set to List View, bins  
are displayed in name order among the clips.

Managing media in bins
Now that we have some bins, let’s put them to use. As you move clips into bins, use 
the disclosure triangles to hide their contents and tidy up the view.

1	 Drag the clip Lower_Third.ai into the Illustrator files bin.

2	 Drag DoubleIdentity.psd into the PSD files bin.

3	 Drag the Title_wLayers bin (created automatically when you imported the 
layered PSD file) into the PSD files bin. Bins inside bins work just like folders 
inside folders.

4	 Drag the clip Seattle_Skyline.mov into the City Views bin. You might need to 
resize the panel or switch it to full-screen to see both the clip and the bin.

5	 Drag the sequence First Sequence into the Sequences bin.

6	 Put all of the remaining clips inside the Double 
Identity bin.

You should now have a nicely organized Project 
panel, with each kind of clip in its own bin.

Notice that you can also copy and paste clips to make 
extra copies if this suits your organizational system. 
You have a Photoshop document that might be useful 
for the Double Identity content. Let’s make an extra copy.

P	Note:  When you 
import an Adobe 
Photoshop file with 
multiple layers and 
choose to import 
as a sequence, 
Adobe Premiere Pro 
automatically creates 
a bin for the individual 
layers and their 
sequence.

E	Tip:  You can 
make Shift+click 
and Control+click 
(Windows) or 
Command+click 
(Mac) selections in the 
Project panel, just as 
you can with files in 
your hard drive.
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7	 Click the disclosure triangle for the PSD files bin to display the contents.

8	 Right-click the DoubleIdentity.psd clip, and choose Copy.

9	 Click the disclosure triangle for the Double Identity bin to display the contents.

10	Right-click the Double Identity bin, and choose Paste.

Adobe Premiere Pro places a copy of the clip in the Double Identity bin.

Finding your media
If you’re not sure where your media is on your hard drive, right-click the clip in the 
Project panel and choose Reveal in Explorer (Windows) or Reveal in Finder (Mac).

Adobe Premiere Pro will open the folder on your hard drive that contains the media 
file and highlight it. This can be very useful if you are working with media files stored 
on multiple hard drives or if you have renamed your clips in Adobe Premiere Pro.

Changing bin views
Though there is a distinction between the Project panel and bins, they have the 
same controls and viewing options. For all intents and purposes, you can treat the 
Project panel as a bin.

Bins have two views. You choose between them by clicking the List View or Icon 
View button at the bottom left of the Project panel.

•	 List View: Displays your clips and bins as a list, with a significant amount of 
metadata you can scroll through.

•	 Icon View: Displays your clips and bins as thumbnails you can rearrange and 
play back.

The Project panel has a Zoom control, which 
changes the size of the clip icons or thumbnails.

1	 Double-click the Double Identity bin to open it in its own panel.

2	 Click the Icon View button on the Double Identity bin to display thumbnails for 
your clips.

3	 Try adjusting the Zoom control.

Adobe Premiere Pro can display very large thumbnails to make browsing and 
selecting your clips easy.

4	 Switch the view to List View.

P	Note:  When you 
make copies of clips, 
you are not making 
copies of the media 
files they are linked to. 
You can make as many 
copies as you like of a 
clip inside your Adobe 
Premiere Pro project. 
Those copies will all link 
to the same original 
media file.
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5	 Try adjusting the Zoom control for the bin.

When in List View, it doesn’t make that much sense to zoom, unless you turn on 
the display of thumbnails in this view.

6	 Click the Panel menu, and choose Thumbnails.

Adobe Premiere Pro now displays thumbnails in List View, as well as in Icon View.

7	 Try adjusting the Zoom control.

The clip thumbnails show the first frame of the 
media. In some cases, this is not particularly 
useful. Look at the clip 16B_SER4, for example. The 
thumbnail shows an empty armchair, but it would 
be useful to see who will be sitting in it.

8	 Click the Panel menu, and choose Preview Area.

9	 Select the clip 16B_SER4 so that information about it is displayed in the 
Preview Area.

10	The Thumbnail Viewer in the Preview Area allows you to play your clip, 
drag through it, and set a new poster frame. Drag through the clip using the 
Thumbnail Viewer until you see the actress sitting in the chair.
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11	Click the Poster Frame button on the Thumbnail  
Viewer.

Adobe Premiere Pro shows your newly selected frame 
as the thumbnail for this clip.

12	Use the panel menu to turn off thumbnails in List 
View and to hide the Preview Area.

Assigning labels
Every item in the Project panel has a label color. In List View, the Label heading 
shows the label color for every clip. When you add your clips to a sequence, they 
will appear in the Timeline panel with this color.

Let’s change the color for the title so that it matches the other clips in this bin.

1	 Right-click DoubleIdentity.psd and choose Label > Iris.

2	 Make sure the DoubleIdentity bin is active by clicking once somewhere inside 
the panel.

3	 Press Control+A (Windows) or Command+A (Mac) to select every clip in 
the bin.

4	 Right-click any of the clips in the bin, and 
choose Label > Forest.

Changing the available label colors
Eight available colors can be assigned as labels to items in your project. There are 
also eight types of item that label colors can be assigned to, and this means there 
aren’t any spare label colors.

If you choose Edit > Preferences > Label Colors (Windows) or Premiere Pro > 
Preferences > Label Colors (Mac), you can see the list of colors, each with a color 
swatch you can click to change the color to something else.

If you select Label Defaults in the preferences, you can choose different default 
labels for each kind of item in your project.

P	Note:  You can 
change the label color 
for multiple clips by 
choosing them first.



Adobe Premiere Pro CS6 Classroom in a Book  87

Changing names

Because clips in your project are separate from the media files they link to, you can 
rename items inside Adobe Premiere Pro, and the names of your original media files 
on the hard drive are left untouched. This makes renaming clips safe to do!

1	 Right-click the clip DoubleIdentity.psd, and choose Rename.

2	 Change the name to DI Title BW.

3	 Right-click the newly renamed clip, DI Title BW, and choose Reveal in Explorer 
(Windows) or Reveal in Finder (Mac).

Notice the original filename has not changed. It’s helpful to be clear about the 
difference between your original media files and the clips inside Adobe Premiere 
Pro because it explains much of the way Adobe Premiere Pro works.

Customizing bins
Adobe Premiere Pro displays certain types of information in the Project panel by 
default. You can easily add or remove headings. Depending on the clips you have 
and the types of metadata you are working with, you might want to display or hide 
different kinds of information.

1	 If it’s not open already, open the Double Identity bin.

2	 Click the Panel menu, and choose Metadata Display.

The Metadata Display panel allows you to choose any kind of metadata to use as 
a heading in the List View of the Project panel (and any bins). All you have to do 
is select the checkbox for the kind of information you would like to be included.

3	 Click the disclosure triangle for Adobe Premiere Pro Project Metadata to show 
those options.

4	 Select the Media Type checkbox.

5	 Click OK.

P	Note:  When you 
change the name of a 
clip in Adobe Premiere 
Pro, the new name is 
stored in the project file. 
Two project files could 
easily have different 
names for the same clip.
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You’ll notice that Media Type is now added as a heading for the Double Identity bin 
but not for any other bins. To make this kind of change to every bin in one step, use 
the Panel menu on the Project panel, rather than on an individual bin.

Some of the headings are for information only, while others can be edited directly. 
The Scene heading, for example, allows you to add a scene number for each clip.

Notice that if you enter a number for a scene and then press the Enter key, Adobe 
Premiere Pro activates the next scene box. This way, you can use the keyboard to 
quickly enter information about each clip, jumping from one box to the next.

The Scene heading is a special one. It gives you information about what the scene 
clips are intended for; it also gives Adobe Premiere Pro information about which 
scene from an original script should be used for automatic analysis of the audio (see 
“Organizing media with content analysis” later in this chapter).

Adobe Story
Adobe Story is a script-writing application that automates the process of cor-
rectly formatting scripts and integrates into your editing workflow with Adobe 
Premiere Pro.

As well as giving you tools for script writing, Story supports collaboration with other 
writers, automatic versioning, and tagging scripts with metadata for preproduction 
planning, and it can generate script reports and schedules to help you prepare for 
production.

Having multiple bins open at once
When you double-click a bin, by default, Adobe Premiere Pro opens the bin in a 
floating panel. Every bin panel behaves in the same way, with the same options, but-
tons, and settings.

If you have room on your computer monitor, you can have as many bins open as 
you like.
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Bins are like any other kind of panel in that you can drag them to any part of the 
interface, resize them, combine them with other panels, and toggle them between 
full-screen and frame display using the ` (grave) key.

Bins open in their own panel when you double-click them because of the default 
preferences, which you can change to suit your editing style.

Choose Edit > Preferences > General (Windows) or Premiere Pro > Preferences > 
General (Mac) to change the options.

Each of the options lets you choose what will happen when you double-click, 
double-click with the Control (Windows) or Command (Mac) key, or double-click 
with the Alt (Windows) or Option (Mac) key.

Organizing media with content analysis
Increasingly, metadata is used to help you stay organized and share information 
about your clips. The challenge with metadata is in finding efficient ways to create 
it and add it to your clips.

To make this process much easier, Adobe Premiere Pro can analyze your media and 
automatically create metadata based on the content. The words that are spoken can 
be added as time-based text, and clips with faces can be marked as such to make it 
easier to identify useful shots.

Attaching a script or transcript
Adobe Premiere Pro has a Speech to Text function that listens to the words spoken 
in your footage and creates text associated with your clips. The text is linked in time 
to when the words are spoken, so you can easily locate the part of a clip you want.

The accuracy of the analysis depends on several factors. You can help Adobe 
Premiere Pro correctly identify the words that are spoken by associating a script or 
transcript with your clips.
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Speech analysis
To initiate the Speech to Text function, do the following:

1	 Import the video file CU MAGE STT.mp4 from the Assets/Speech to text folder.

2	 Scroll along in the Project panel until you can see the Scene heading. Add the 
scene number 1 for the CU MAGE STT.mp4 clip.

3	 Double-click the CU MAGE STT.mp4 clip. If the Double Identity bin obscures 
the Source Monitor, you can close the bin by clicking on the X on the bin's 
panel tab.

Adobe Premiere Pro displays it in the Source Monitor.

4	 Click the tab for the Metadata panel to display it. In the default Editing 
workspace, you’ll find the Metadata panel sharing a frame with the Program 
Monitor. If it isn’t there, click the Window menu, and choose Metadata.

The Metadata panel shows you many different kinds of metadata about clips in 
your project.

5	 Click the Analyze button 
at the bottom right of the 
Metadata panel.

The Analyze Content panel 
gives you options for how 
the automatic analysis will 
take place. You simply need 
to decide whether you want 
Adobe Premiere Pro to 
detect faces and/or identify 
speech and then choose the 
language and the quality 
settings.

To help the speech detection 
improve accuracy, we’re 
going to attach a script file.

6	 Click the Reference Script 
menu, and choose Add.

P	Note:  There’s a zip 
file in that folder with 
an original copy of the 
video clip, so you can 
try this again if you’d 
like. Once you use the 
Adobe Premiere Pro 
Speech to Text feature, 
the original file has the 
additional metadata 
added, which will be 
available whenever you 
import it.
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7	 Browse to the Assets/Speech to text folder, and open Paladin_Script_Final.astx. 
Adobe Premiere Pro displays the Import Script dialog so you can confirm you 
have chosen the right script. Notice there’s a checkbox to confirm the script text 
exactly matches the recorded dialogue. This forces Adobe Premiere Pro to use 
only the words in the original script (useful for interview transcriptions). Click 
OK, without selecting the check box.

8	 Select the Identify Speakers checkbox in the Analyze Content panel.

This tells Adobe Premiere Pro to separate dialogue from different voices.

9	 Leave all of the other settings at their defaults, and click OK.

Adobe Premiere Pro starts the Adobe Media Encoder, which conducts the 
analysis in the background. This allows you to carry on working in your project 
while the analysis happens. When the analysis is complete, a text description of 
the words spoken is displayed for the clip in the Metadata panel.

Adobe Media Encoder starts the analysis automatically and plays a completion 
sound when it has finished. You can set off multiple clips for analysis, and Adobe 
Media Encoder will automatically add them to a queue. You can quit Adobe 
Media Encoder when it has completed its tasks.

Face detection
With so many clips in larger projects, anything that makes finding the right shot 
easier helps. Turning on face detection when analyzing your clips adds an extra way 
of searching for content.

Now that you have analyzed the CU MAGE STT.mp4 clip, try clicking the Recent 
Searches button for the Filter Bin Content box in the Project panel and choosing Find 
Faces. The CU MAGE STT.mp4 shot will be displayed, even if you put it into a bin. 
Be sure to click the X on the right of the Filter Bin Content box to clear your filter.

Monitoring footage
The greater part of video editing is invested in watching clips and making creative 
choices about them. It’s important to feel really comfortable browsing media.

Adobe Premiere Pro has multiple ways of performing common tasks such as play-
ing video clips. You can use the keyboard, click buttons with your mouse, or use an 
external device like a jog/shuttle control.

Adobe Premiere Pro CS6 has a new browsing feature called hover scrub that allows 
you to view the contents of your clips quickly and easily right in the bin.

1	 Double-click the Double Identity bin to open it.

2	 Click the Icon View button at the bottom-left corner of the bin.

E	Tip:  Adding a scene 
number for your clips 
helps Adobe Premiere 
Pro identify the part of 
the script the dialogue 
relates to.



92  Lesson 4 O rganizing Media

3	 Drag your mouse, without clicking, across any of the images in the bin.

Adobe Premiere Pro displays the contents of the clip as you drag. The left edge of 
the thumbnail represents the beginning of the clip, and the right edge represents 
the end. In this way, the width of the thumbnail represents the whole clip.

4	 Select a clip by clicking it once. Hover scrubbing is now turned off, and a mini 
scrollbar appears at the bottom of the thumbnail. Try dragging through the clip 
using the scrollbar.

Adobe Premiere Pro uses the J, K, and L keys on your keyboard to perform 
playback too, just like the Media Browser.

•	 J: Play backward

•	 K: Pause

•	 L: Play forward

5	 Select a clip, and use the JKL keys to play the thumbnail. Be sure to click the clip 
only once. If you double-click, it will open in the Source Monitor.

When you double-click a clip, not only is it  
displayed in the Source Monitor, it’s also added 
to a list of recent clips.

E	Tip:  If you press the 
J or L key multiple times, 
Adobe Premiere Pro will 
play the video clips at 
multiple speeds.
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6	 Double-click to open four or five clips from the Double Identity bin.

7	 Click the Recent Items menu, on the tab at the top of the Source Monitor, to 
browse between your recent clips.

E	Tip:  Notice that you have the option to close a single clip or close all clips, clearing the menu and 
the monitor. Some editors like to clear the menu and then open several clips that are part of a scene 
by selecting them all in the bin and dragging them into the Source Monitor together. They can then 
use the recent items menu to browse only the clips from this short list.

8	 Click the Zoom menu at the bottom of the Source Monitor.  
By default, this is set to Fit, which means Adobe Premiere Pro 
will display the whole frame, regardless of the original size. 
Change the setting to 100%.

These Double Identity clips are high-resolution, and they are probably much 
bigger than your Source Monitor. You are likely to have scrollbars at the bottom 
and on the right of your Source Monitor now, so you can view different parts of 
the image.

The benefit of viewing with Zoom set to 100% is that you see every pixel of the 
original video, which is useful for checking the quality.

9	 Set the Zoom back to Fit.

Playback resolution

If you have an older or slower processor, your computer may 
struggle to play back very high-quality video clips. To work 
with a wide variety of computer hardware configurations, from 
powerful desktop workstations to lightweight portable laptops, Adobe Premiere 
Pro can lower the playback resolution to make playback smoother. You can switch 
the playback resolution as often as you like, using the Select Playback Resolution 
menu on the Source (and Program) Monitor.

Timecode information

At the bottom left of the Source Monitor, a timecode display shows the current 
position of the playhead in hours, minutes, seconds, and frames (00:00:00;00).

At the bottom right of the Source Monitor, a timecode display shows the total 
selected duration for your clip. Later, you’ll be adding special marks to make a par-
tial selection. For now, it shows the complete duration.
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Safe margins

Old-style CRT monitors crop the edges of the picture to achieve a clean edge. If 
you are producing video for a CRT monitor, click the Settings (spanner icon) but-
ton at the bottom of the Source Monitor and choose Safe Margins. Adobe Premiere 
Pro displays white outlines over the image.

The outer box is the Safe Action zone. Aim to keep important action inside this box 
so that when the picture is displayed, cropping does not hide what is going on.

The inner box is the Title Safe zone. Keep titles and graphics inside this box so that 
even on a badly calibrated display, your audience will be able to read the words.

Click back into the Settings button at the bottom of the Source Monitor and 
choose Safe Margins to turn them off.

Essential playback controls
Let’s look at the playback controls.

1	 Double-click the shot 16_6B in the Double Identity bin to open it in the Source 
Monitor.

Navigator Step back Step forwardPlay

Playhead Time ruler

2	 At the bottom of the Source Monitor, there’s a yellow playhead marker. Drag 
it along the bottom of the panel to view different parts of the clip. You can 
also click wherever you want the playhead to go, and it will jump to wherever 
you click.
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3	 Below the clip navigation bar and the playhead, there is a scrollbar that 
doubles as a Zoom control. Drag one end of the scrollbar to zoom in on the 
clip navigator.

Drag here Drag here

4	 Click the Play button to play the clip. Click it again to stop playback. You can 
also use the spacebar to play and stop playback.

5	 Click the Step back and Step forward buttons to move through the clip one 
frame at a time. You can also use the left- and right-arrow keys on your 
keyboard.

6	 Use the J, K, and L keys to play your clip.

Customizing the monitors
To customize your monitors, click the Settings button  on the Source Monitor.

This menu gives you several different display options for your Source Monitor (the 
Program Monitor has a similar menu). You can choose to view waveforms and vec-
tor scopes to analyze your video.

For now, we just want to know how to get regular video on-screen. Make sure 
Composite Video is selected in this menu.

You can add or remove buttons at the bottom of the Source Monitor.

1	 Click the Button Editor button at the bottom right of the Source Monitor.

A special set of buttons appears.

2	 Drag the Loop button  from the floating panel to the right of the Play button 
on the Source Monitor, and click OK.

3	 Double-click the di05c_compv_02 clip in the Double Identity bin to open it in 
the Source Monitor.

4	 Click the Loop button to enable it, and then play the video using the spacebar or 
the Play button on the Source Monitor. Stop the playback when you have seen 
enough.

With Loop turned on, Adobe Premiere Pro continuously repeats playback.
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Modifying clips
Adobe Premiere Pro uses metadata associated with clips to know how to play them 
back. Occasionally, this metadata will be wrong, and you’ll need to tell Adobe 
Premiere Pro how to interpret a clip.

You can change the interpretation of clips for one file or multiple files in a single 
step. To do so, just select the clips you want to change.

Adjusting audio channels
Adobe Premiere Pro has advanced audio management features. You can create 
complex sound mixes and selectively target output audio channels with original 
clip audio. You can produce Mono, Stereo, 5.1, and even 16-channel sequences with 
precise control over which audio goes where.

If you’re just starting out, you’ll probably want to produce stereo sequences and 
might well be working with stereo source material. In this case, the default settings 
are most likely exactly what you need.

When recording audio with a professional camera, it’s common to have one micro-
phone record onto one audio channel and a different microphone record onto 
another audio channel. Though these are the same audio channels that would be 
used for regular stereo audio, they now contain completely separate sound.

Your camera adds metadata to the video that is recorded to tell Adobe Premiere Pro 
whether the sound is meant to be mono (separate audio channels) or stereo (chan-
nel 1 audio and channel 2 audio combine to produce the complete stereo sound).

You can tell Adobe Premiere Pro how to interpret audio channels when new media 
files are imported by going to Edit > Preferences > Audio > Channels (Windows) or 
Premiere Pro > Preferences > Audio > Channels (Mac).

If the setting was wrong when you imported your clips, it’s easy to tell Adobe 
Premiere Pro how to correctly interpret the audio channels.

1	 Right-click the CU MAGE STT.mp4 clip in the Project panel, and choose 
Modify > Audio Channels.
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2	 Right now, this clip is set to use the file’s metadata to identify the channel 
format for the audio. Click the Preset menu, and change it to Mono.

Adobe Premiere Pro switches the Channel Format menu to mono. You’ll see the 
Left and Right Source Channels are now linked to track Audio 1 and Audio 2. 
This means that when you add the clip to a sequence, each audio channel will go 
on a separate track, allowing you to work on them independently.

3	 Click OK.

Interpreting footage
For Adobe Premiere Pro to interpret a clip correctly, it needs to know the frame rate 
for the video, the pixel aspect ratio (the shape of the pixels), and the order to display 
the fields, if your clip has them. Adobe Premiere Pro can find out this information 
from the file’s metadata, but you can change the interpretation easily.

1	 Import RED Video.R3D from the Lesson 04 folder. Double-click it to open it in 
the Source Monitor. It’s full anamorphic widescreen, which is a little too wide 
for our project.

2	 Right-click the clip in the bin, and choose Modify > Interpret Footage.

3	 Right now, the clip is set to use the Pixel Aspect Ratio setting from the file: 
Anamorphic 2:1. This means the pixels are twice as wide as they are tall.

4	 Change the Pixel Aspect Ratio setting to Conform to:, and select DVCPRO HD 
(1.5). Then click OK.

From now on, Adobe Premiere Pro will interpret the clip as having pixels that are 
1.5 times wider than they are tall. This reshapes the picture to make it standard 
16:9 widescreen. This won’t always work—in fact, it usually introduces unwanted 
distortion—but it can provide a quick fix for mismatched media (a common 
problem for news editors).

Working with RED files
Adobe Premiere Pro has special settings for R3D files created by RED cameras. 
R3D files are very similar to the camera raw format used by professional DSLR still 
cameras. Raw files always have a layer of interpretation applied to them in order to 
view them. You can change the interpretation at any time without impacting play-
back performance in Adobe Premiere Pro. This means you can make changes, for 
example, to the colors in a shot without requiring any extra processing power. You 
could achieve a similar result using a special effect, but your computer would have 
to do more work to play the clip.
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The added benefit is that the changes made using RED source settings apply to 
the original media files, so you can update the way colors are interpreted at a later 
stage in your edit and see the results in clips that are already in a sequence.

1	 Right-click the RED Video.R3D clip in the Project panel, and choose Source 
Settings.

The RED R3D Source Settings dialog appears, giving you access to all of the 
original interpretation controls for the clip you select. In many ways, this is a 
powerful color correction tool, with automatic white balance and individual 
adjustment of the red, green, and blue values.

2	 On the right, there is a series of individual controls for adjusting the picture. 
Scroll down to the very end of the list, where you’ll find Gain Settings. Since this 
is a RED clip, let’s increase the Red gain to about 1.5. You can drag the slider 
control, click and drag the orange number, or click and type over the number.

3	 Click OK, and take another look at the clip in the Source Monitor.

The picture has updated. If you had already edited this clip into a sequence, it 
would update inside the sequence, too.

For more information about working with RED media, go to  
http://www.adobe.com/go/red/.

http://www.adobe.com/go/red/
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Review questions
1	 How do you change the List View headings in the Project panel?

2	 How can you quickly filter the display of clips in the Project panel to make finding 
a clip easier?

3	 How do you create a new bin?

4	 If you change the name of a clip in the Project panel, does it change the name of the 
media file it links to on your hard drive?

5	 What keys can you use to play back video and sound clips?

6	 How can you change the type of audio channels on a clip if they are not set up in the 
way you’d like to work?

Review answers
1	 Click the Panel menu for the Project panel, and choose Metadata Display. Select the 

checkbox for any heading you would like to appear.

2	 Click into the Filter Bin Content box, and start typing the name of the clip you are 
looking for. Adobe Premiere Pro hides any clips that don’t match and displays those 
that do.

3	 Click the New Bin button at the bottom of the Project panel. Or, go to the File menu 
and choose New > Bin. Or, right-click a blank area in the Project panel and choose 
New Bin. Or, press Ctrl+/ (Windows) or Command+/ (Mac). You can also drag and 
drop clips onto the New Bin button on the Project panel.

4	 No, you can duplicate, rename, or delete clips in your Project panel, and nothing will 
happen to your original media files. Adobe Premiere Pro is a nondestructive editor and 
will not modify your original files.

5	 The Spacebar plays and stops. J, K, and L can be used like a shuttle controller to play 
backward and forward, and the arrow keys can be used to move one frame backward 
or one frame forward.

6	 Right-click the clip you want to change, and choose Modify > Audio Channels. Choose 
the correct option (usually by selecting a preset), and click OK.
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review of, 203
starting, 172
time remapping, 177–180
trimming, generally, 189–195
trimming in Program Monitor, 

195–202
AES audio, 449
After Effects. See Adobe After 

Effects CS6
Aggressive mode, 370
AIFF (Audio Interchange File 

Format), 436
alignment of titles, 391, 406–407
alpha-channel transparencies, 

366–367
alpha channels, 361–363
Alt keys. See keyboard shortcuts
Amount to Decolor controls, 353
amplitude, 253
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Analyze Content panel, 90–91
anchor points

in Motion effect, 214–215
to In and Out points, 317
settings for, 207–208
in Titler, 404

Anchor to In Point, 317
Anchor to Out Point, 317
angles in multicam editing, 241
Animated GIF files, 437
animated text, 410–413
Animation codec, 435
anti-aliases, 61
Anti-Flicker Filter, 208
appearance of titles, 397–398
Apple ProRes codec, 39
Apply Default Transitions to 

Selection, 197
Assemble a timecode, 448
assembly edits, 122
assessing color, 346
assets

importing, 50–54
Media Browser locating, 56–58
organizing. See organizing media
in Project panel, 79

audio channels
adjusting, 96–97
assigning, 447
defined, 248

Audio display format, 33
audio editing

5.1 mixes in, 266
adding delays, 272
audio channels in. See audio 

channels
Audio Gain panel, 256–257
audio levels, generally, 249
audio levels in sequences, 

260–264
audio meters for, 249
Audio Mixer for. See Audio Mixer
audio waveforms in, 250–251
Audio workspace for, 247
Audition for. See Adobe 

Audition CS6
automation modes for, 265–266

audio editing (continued)
bass adjustments, 271
characteristics of tracks in, 

252–253
Dynamics effect for, 288–289
Effects Controls panel for, 

254–255
effects in, 271–275
EQ adjustments in, 275–279
Highpass effects in, 286–287
initial mixes, 280–282
interfaces for, 247–252
introduction to, 12
J-cuts in, 259–260
keyframing volume changes 

in, 261
L-cuts in, 260
Lowpass effects in, 286–287
Master track output in, 248
monitoring, 252
multicamera, 242
noisy audio cleanup, 286–292
normalizing, 257–259
Notch effect for, 287
Notch effect in, 287
overall clip level adjustments, 

260–261
overview of, 244–246
parametric EQ in, 278–279
pitch adjustments, 272–273
removing background noise in, 

290–292
reverb adjustments, 274–275
review of, 267, 293
samples of, 250
smoothing volume between 

keyframes in, 262
split edits in, 259–260
standard, 251
standard EQ in, 275–278
starting, 246
submixes, applying effects to, 

284–285
submixes, generally, 282–284
submixes in, 265
sweetening, generally, 268–269
sweetening, starting, 270

sweetening with audio effects, 
271–275

track vs. clip keyframes in, 
262–263

transitions in, 166–168
treble adjustments, 273–274
volume adjustment, 254–255, 262

Audio Gain panel, 256–257
Audio Interchange File Format 

(AIFF), 436
audio levels

in clips overall, 260–261
introduction to, 249
in sequences, 260–264

Audio Master settings, 41
audio meters, 249
Audio Mixer

applying effects to submixes in, 
284–285

for audio tracks, 247, 262–266
creating initial mixes in, 280–282
creating submixes in, 282–284
effects in, 279–285
introduction to, 18

audio recording, 62–63
Audio Samples mode, 33
Audio tab, 440
Audio tracks options, 42
audio transitions, 166–168
audio waveforms, 250–251
Audition. See Adobe Audition CS6
authoring DVDs. See Adobe 

Encore CS6
Auto Bezier interpolation, 219, 315
Auto Levels controls, 350
AutoGate option, 288–289
automated editing, 139
automation modes, 265–266
Autoplay DVD creation, DVD 9–12
Avid Media Composer, 44–45

B

background noise, 290–292
background pixels, 365–366
bands, defined, 275
Basic 3D effect, 227–228
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Bass effect, 271
batch capture, 69–72
Bevel Edges effect, 224–225
Bezier interpolation, 219, 315
bins

creating, 82–83
customizing, 87–88
defined, 11, 76, 80
labels in, 86–87
managing media in, 83–84
multiple, 88–89
names in, 87
for organizing media, generally, 82
views in, 84–86

Black & White effect, 302, 340
blacking tapes, 447
blending mode, 363–366
Blu-ray

creating discs for, DVD:7, DVD:9
encoding for, 438
Encore for, DVD:18
file formats in, 436, 438

blur effects, 369
bounding boxes, 384–385, 392–396
Bridge, 14
Brightness & Contrast effect, 345
brightness of text, 22
Broadcast Colors effect, 344
broadcast legalization, 355
broadcast-safe colors, 398
browsing features, 91–94
built-in presets, 315–316
bumpers, 382
Bypass check boxes, 278–279

C

C (chrominance), 332
Capture Format settings, 33–34
Capture Noise Print (Shift+P), 291
certification, 6
Change Clip Speed, 172
Change Color effect, 341
Change to Color effect, 341, 354
chapter markers, DVD 7–9
characteristics of audio tracks, 

252–253

Chroma controls, 333
Chromakey effects, 368
chrominance (C), 332
Classroom in a Book, 1–6
cleaning up noisy audio, 286–292
clip, defined, 350
Clip markers, 138
Clip Speed/Duration keyboard 

shortcuts, 175
clipboard, 146
clips

adding to Timeline, 130
changing position of, 211–213
clipboard for, 146
defined, 26
deleting segments of, 146
disabling, 148
dragging, 144
editing into sequences, 133
exporting. See export options
extracting segments of, 146
Insert edits of, 131–133
Lift for, 146–147
linking, 143
markers for. See markers
modifying, 96–98
in motion. See Motion effect
moving, 144–146
in multicamera editing, 236–237
online vs. offline, 419
paused resolution for, 134–135
playback resolution for, 134
Program Monitor for, 128–133
rearranging in sequences, 145
resolution control for, 133–135
retiming, 174–180
review of, 149
Ripple Delete for, 147
selecting, 141–143
sending to After Effects, 308–310
sending to SpeedGrade, 356
Source vs. Program Monitor 

for, 129
splitting, 143
Timeline gaps and, 141–143
unlinking, 143
working with, generally, 126–128

codecs
defined, 437
for DVDs, DVD 7
for video files, 39–40

collaboration, 425
collecting files, 423
color

correcting. See color correction
effects for, 340
grading utilities. See Adobe 

SpeedGrade CS6
in greenscreen shots, 368–371
in labels, 86
stops, 375–376
in titles, 388
tool for, 398
workflows oriented to, 328–329

color correction
additive vs. subtractive colors 

in, 337
assessing, 346
balance in, 347–353
Black & White effect, 340
Broadcast Colors effect, 344
broadcast legalization in, 355
Change Color effect, 341
Change to Color effect, 341, 354
color balance solutions, 347–353
color-oriented effects for, 340
color-oriented workflows for, 

328–329
coloring effects for, 340
combination views for, 339
creating looks with, 355–356
effects for, 342–344
exposure problems and, 344–346
Fast Color Corrector, 342, 

347–348
introduction to, 12
Leave Color effect, 341, 353–354
levels in, 350
in overexposed images, 346
overview of, 326–327
primary, 348–351
primary vs. secondary colors 

in, 335
Reference Monitor for, 331–339
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color correction (continued)
removing color, 341
replacing color, 341
review of, 357
RGB Color Corrector for, 343
RGB Curves effect for, 342–343
RGB parade in, 337
secondary, 348, 351–353
special color effects in, 353–355
SpeedGrade for, 356
starting, 328
technical color effects for, 343
Three-Way Color Corrector 

for, 342
Tint effect for, 340
in underexposed images, 345
Vect/YC Wave/RGB parade 

for, 339
Vect/YC Wave/YCbCr parade 

for, 339
vectors in, 338
vectorscope in, 334–337
Video Delimiter effect for, 343
video scope essentials in, 330
White Balance control for, 

347–348
workspace for, 329
YC Waveform in, 332–334
Y'CbCr parade in, 338

color-oriented effects, 340
color-oriented workflows, 328–329
Color tool, 398
coloring effects, 340
combination views, 339
Command keys. See keyboard 

shortcuts, Mac OS
commands for video editing, 116–124
Community Help, 3, 5
component videos, 449
compositing

alpha-channel transparencies in, 
366–367

alpha channels in, 361–362
blending mode and, 365–366
color keying in, 368–371
custom matte creation in, 

374–376

defined, 362
greenscreen shots in, 368–371
keyframing opacity in, 365
mattes in, generally, 371–372
mattes using graphics/clips 

in, 373
Opacity effect in, 364–366
overview of, 358–360
preprocessing footage in, 

368–369
review of, 379
Roto Brush Tool in, 378
shooting videos for, 362–363
starting, 360
terminology of, 363–364
Title for, 374–376
Track Matte Key effect in, 373
traveling mattes, 376–377
Ultra Key effect in, 369–371
using in projects, 362

Compressor option, 288–289
conforming sequences, 111
Constant Gain crossfades, 166
Constant Power crossfades, 166–168
content analysis

face detection for, 91
introduction to, 89
for organizing media, 89–91
script attachment in, 89
speech analysis for, 89–90
transcript attachment in, 89

continuity issues, 131
Continuous Bezier interpolation

in keyframe video effects, 315
Motion effect and, 219
smoothing between keyframes 

with, 262
Control keys. See keyboard 

shortcuts, Windows
controls in video editing, 105
Copy clips keyboard shortcuts, 146
copying files, 3, 423
crawling text, 408–409
Create bin keyboard shortcuts, 83
creating looks, 355–356
Creative Suite 6 Production 

Premium, 15, 22

Cross Dissolve effects
in one-second transitions, 159
in photo montages, 161
in sequences, 168
in single-sided transitions, 156
in two-second transitions, 155

crossfades, 166–167
CRT monitors, 94
Ctrl keys. See keyboard shortcuts, 

Windows
CUDA (Mercury Playback Engine 

GPU Acceleration), 30–31
customization

of bins, 87–88
of mattes, 374–376
of monitors, 95
of presets, 39
of Project panel, 78
of titles, 399
of workspaces, 19–22

D

Delay effect, 271–272, 275
Delay movie start by x frames, 448
Delete clips (Shift+Delete), 147
deleting segments, 146
DeNoiser effect, 271
Density controls, 275
Design Center, 5
developer products, 5
Device Control settings, 446–447
devices, encoding for, 438
Digital Picture Exchange (DPX), 436
disabling clips, 148
disclosure triangles, 37
Distance to Image property, 228
double roller trims, 191
downstream effects, 180
DPX (Digital Picture Exchange), 436
dragging clips, 144, 180–181
dragging In and Out points, 188
drawing keyboard shortcuts, 

403–404
Drop Shadow effect, 222–223
drop zones, 20–21
dropping frames, 28
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duration of clips, 174–180
DV capture, 33
DVDs

authoring, DVD:2–DVD:7
Autoplay creation of, DVD 9–12
chapter markers in, DVD:9
codecs for, DVD 7
encoding for, 438
file formats for, 436, 438
menus in, DVD 13–17
previewing, DVD 17–18

Dynamic Link
file formats in, 438
importing media with, 65
introduction to, 14–15, 65
for project management, 426
sending clips to After Effects 

with, 308
sending titles to After Effects 

with, 410
dynamic trimming, 200–201
Dynamics effect, 288–289

E

Ease In interpolation, 315
Ease options, 220–222
Ease Out interpolation, 315
echoes, 272
edit decision lists (EDLs), 445
Edit Original option, 61
edit points, 154–155
EDLs (edit decision lists), 445
Effect Controls panel

audio tracks in, 254–255
in Color Correction 

workspace, 329
introduction to, 19
for transitions, 152–153, 161–163

Effects and sends controls, 264
Effects Browser, 299–300
effects, color, 342–344
Effects panel, 18, 21
Ellipse tool, 375
Embed audio, 444
Encapsulate, 444

encoding. See Adobe Media 
Encoder CS6

Encore. See Adobe Encore CS6
EQ (equalization), 275–279
equalization (EQ), 275–279
exclamation points, 398
Expander option, 288–289
Exponential Fade transitions, 167
Export Frame (Shift+E), 432
Export Media keyboard 

shortcuts, 434
export options

to AAF, 443–444
Activate Recording Device, 448
AES audio, 449
Assemble a timecode, 448
audio channel assignments, 447
Audio tab, 440
codecs in, 434–435
component video, 449
Delay movie start by x frames, 448
Device Control settings, 446–447
for DVD projects, DVD 19–20
edit decision lists and, 445
Embed audio, 444
Encapsulate, 444
Export directly, 441
Export Frame for, 431
Export Settings for, 439
file formats in, 436
filters, 439–440
for Final Cut Pro XML files, 443
FTP uploads, 440
for master copies, 433–435
Media Encoder for. See Adobe 

Media Encoder CS6
Metadata Export panel, 441
Multiplexer controls, 440
to OMF, 443–444
overview of, 428–430
Preroll x frames, 448
Queue button, 441
recording to DV/HDV, 448
recording to tape as, 446–447
review of, 450
RS-422 deck control, 449

Save as legacy AAF, 444
Separate Audio, 444
Serial Digital Interface, 449
for single frames, 431–432
to SpeedGrade, 446
starting to use, 430
third-party hardware capture, 449
Use Frame Blending, 441
Use Maximum Render 

Quality, 440
Use Previews, 441
Video tab, 440
for Web, DVD 19–20
XLR audio, 449

exposure problems, 344–346
extracting segments, 146
Eyedropper tool, 397

F

F4V (Flash version 4 video) files, 436
face detection, 91
fades, 166–168
Fast Color Corrector, 342, 347–348
Feedback parameter, 272
Feet + Frames 16mm/35mm, 32
file-based workflows, 54
file formats, 16, 436–438
Fill Type tool, 398
Filter Bin

Find Faces in, 91
organizing media with, 80
in Project panel, 80

filters, 439–440
Final Cut Pro projects, 43
Find Faces feature, 91
Find option, 81
finding media, 84
fine-tuning video transitions, 

161–165
FireWire, 33, 66
First Play items, DVD 11
Fit to Fill, 172
fixed effects, 297–299
Flare Center/Brightness, 312–314
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Flash
converting Encore projects to, 

DVD:19–DVD:20
cue point markers in, 136
file formats in, 436
introduction to, 14–15
Media Encoder and, 429
uploading files to deploy 

with, 438
version 4 files in, 436, 438
video files in, 438

flattened Photoshop files, 58–59
flexibility of text, 387
float processing, 301
FLV (Flash video) files, 436
font choice, 387
foreground pixels, 365–366
forums for Adobe, 5
four-point editing

introduction to, 120, 172
options for, 172–173
performing, 173–174

Four-Point Garbage Matte effect, 372
fps (frames per second), 32
frames. See also keyframes

active, 103
blending, 441
delaying movie start by x, 448
dropping, 28
exporting single, 431
Frames option for, 33
i frames, DVD 7, DVD:9
prerolling, 448

frames per second (fps), 32
frequency ranges

in audio tracks, 252
human audible, 273
in parametric EQ, 278–279
in standard EQ, 276–278

FTP, 440

G

Gain controls, 343
Gamma controls, 343
Gang buttons, 175
Gang to Program Monitor, 331

gaps, 141–143
Garbage Matte effects, 372–373
Gaussian Blur, 439–440
GIF files, 437
Ginger, E.M., 387
Go to In, 105
Go to Out, 105
GOP (group of pictures), DVD 7
GPU (graphics processing unit) 

acceleration
effects in, 301
introduction to, 3, 12
in Mercury Playback Engine, 

30–31
grading color. See Adobe 

SpeedGrade CS6
graphics in Photoshop, 400–401
graphics processing units (GPUs). 

See GPU (graphics processing 
unit) acceleration

grave (`) keys, 78, 89, 103
grayscale, 361
greenscreen shots, 364, 368–371
group of pictures (GOP), DVD 7

H

H.264 files, 436, 438
handles, 154–155, 163–165
hard drives, 35, 425–426
hardware, 12
HD (high-definition) media, 2–3
HDV capture, 33
head handles, 163–165
head material, 154
Help, 3, 5
Hi Damp controls, 275
high-bit-depth effects, 301
high-definition (HD) media, 2–3
highlights, 334
Highlights Balance controls,  

349–350
Highlights controls, 350–351
Highpass effects, 286–287
History panel, 19
Hold interpolation, 219, 315
hover scrub feature, 91

I

i frames, DVD 7, DVD:9
Icon View, 84–85
IDs, 382
IEEE 1394, 33
Ignore Alpha Channel, 367
Ignore Options, 123
Ignore Sequence In Point, 173
Ignore Sequence Out Point, 173
Ignore Source In Point, 172–173
Ignore Source Out Point, 173
i.Link, 33
Illustrator, 14, 61
image stabilization effects, 318–319
images

flattened Photoshop files, 58–59
Illustrator files, 61
introduction to, 58
layered Photoshop files, 59–60

Import keyboard shortcuts, 51, 58
importing media

assets, generally, 50–54
assets location in, 56–58
batch capture for, 69–72
caches in, 64–65
Dynamic Link for, 65
flattened Photoshop files, 58–59
Illustrator files, 61
images, 58–61
Import command for, 51
layered Photoshop files, 59–60
Media Browser for, generally, 

52–54
Media Browser, working with, 

54–58
overview of, 48–49
from Prelude, 53
projects, 424
review of, 73
scene detection in, 72
scratch narration tracks in, 62–63
sequences, 424
starting, generally, 50
tapeless workflows in, 54–55
third-party hardware capture 

in, 66
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video file types in, 55
videotape in, 66–67

In and Out points
clearing, 115
in insert edits, 116, 118
in multicamera editing, 234
setting, 114
in Source Monitor, 106–107
in three-point editing, 120
in Timeline, 114–115
in trimming, 188
for Work Area functions, 116

In Shift Counter, 197
Individual Parameters, 273
Info panel, 19
initial mixes, 280–282
Input Levels controls, 349
Insert edits

of clips, 131–133
extracting/deleting segments in, 

146–148
introduction to, 105
moving clips in, 144
video editing, 116–118

installation of Adobe Premiere Pro, 2
Intensity controls, 333
interactive markers, 138
interfaces for audio, 247–252
interpolation, 218–222, 313–315
interpreting footage, 97
Invert Alpha Channel, 367

J

J-cuts, 259–260
J keys (play backward), 92
jerks, 314
JKL keys, 201
JPEG files, 436
jump cuts, 154

K

K keys (pause), 92, 201
kerning, 389
keyboard shortcuts

Alt (lasso audio clips), 168
Alt+I (Remove In point), 115

Alt+O (Remove Out point), 115
Alt+X (Remove In and Out 

points), 115
for Macs. See keyboard shortcuts, 

Mac OS
Shift + / (add In and Out points), 

114, 146
Shift+` [grave] (toggle screen), 

103
Shift+7 (select Effects 

Browser), 299
Shift+8 (Media Browser), 52
Shift+click (select specified 

items), 83, 168, 175
Shift+Delete (Delete clips), 147
Shift+drag (add shapes), 403
Shift+E (Export Frame), 432
Shift+P (Capture Noise 

Print), 291
for subclips, 109
for trimming, 202
for video editing, 109
for Windows. See keyboard 

shortcuts, Windows
keyboard shortcuts, Mac OS

Alt+drag (select audio or video 
clips), 161

Command+/ (create bin), 83
Command+A (Select All), 58, 

86, 122
Command+Alt (rearrange clips in 

sequences), 145
Command+C (Copy clips), 146
Command+click (Select specified 

items), 53, 83, 242
Command+D (add Video Cross 

Dissolve), 168
Command+I (Import), 51, 58
Command+K (Add Edit to 

selected tracks), 143
Command+M (Export 

Media), 434
Command+R (open Clip Speed/

Duration), 175
Command+T (cycle Trim 

modes), 199–200
Command+T (open New Title), 

393, 403

Command+V (Paste clips), 146
Command+Z (Undo Edit), 123, 

141, 175
Option key (lasso audio clips), 168
Option+drag (draw), 403
Option+drag (select audio or 

video clips), 161
Option+left arrow (Trim 

Backward), 197, 202
Option+right arrow (Trim 

Forward), 197, 202
Option+Shift+left arrow (Trim 

Backward Many), 197, 202
Shift+Command+D (add audio 

transition), 168
Shift+Command+K (Add Edit to 

all tracks), 143
Shift+Command+P (Noise 

Reduction), 291
Shift+Option+drag (constrain 

aspect ratios and draw), 404
keyboard shortcuts, Windows

Alt+drag (draw), 403
Alt+left arrow (Trim Backward), 

197, 202
Alt+right arrow (Trim Forward), 

197, 202
Alt+Shift+left arrow (Trim 

Backward Many), 197, 202
Control+/ (create bin), 83
Control+A (Select All), 58, 86, 122
Control+Alt (rearrange clips in 

sequences), 145
Control+C (Copy clips), 146
Control+click (Select specified 

items), 53, 83, 242
Control+D (add Video Cross 

Dissolve), 168
Control+I (Import), 51, 58
Control+K (Add Edit to selected 

tracks), 143
Control+M (Export Media), 434
Control+R (open Clip Speed/

Duration), 175
Control+T (cycle Trim modes), 

199–200
Control+T (open New Title), 

393, 403
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keyboard shortcuts, Windows 
(continued)

Control+V (Paste clips), 146
Control+Z (Undo Edit), 123, 

141, 175
Shift+Alt+drag (constrain aspect 

ratios and draw), 404
Shift+Control+D (add audio 

transition), 168
Shift+Control+K (Add Edit to all 

tracks), 143
Shift+Control+P (Noise 

Reduction), 291
keyframe interpolation, 218–222, 

313–315
keyframes

animating clips with, 206
for animation, 205–206
changing layer positions with, 

211–212
changing size with, 216–217
controls in, 12
for effects. See keyframing effects
interpolation with, 218–222, 

313–315
Motion effect for, 208–209
reusing Motion settings, 213
for rotation, 214–215
shape of, 219
Show/Hide Timeline View 

for, 208
speed, 178–179
for time remapping, 177–180
track vs. clip, 262–263
in video effects, 311–315
video speed/duration with, 

177–179
volume changes with, 261–262

keyframing effects
adding, 311–312
interpolation in, 218–222, 

313–315
introduction to, 311
opacity, 365
velocity in, 313–315
in video, 311–315

keying, defined, 360

keying out, 363

L

L-cuts, 260
L keys (play forward), 92
labels, 86–87
lasso audio clips shortcuts, 168
Latch mode, 265–266
layered Photoshop files, 59–60, 83
leading, 391
Leave Color effect, 341, 353–354
Lens Flare effect, 311
levels, color, 350
Lift, 146–147
lighting effects, 321–323
Limiter option, 288–289
linear interpolation, 218, 315
linking clips, 143
List View, 84–86
Lo Damp controls, 275
loading footage

from multiple cameras, 233
multiple clips, 104
single clips, 102–103

logos, 402, 405–407
long GOP (group of pictures), DVD 7
Loop function, 95
looser tracking, 390
lower-thirds, 382
Lowpass effects, 286–287
Lucas, George, 154
Luma Curve effect, 344–345
luminance (Y), 332
luminance (Y) channels, 301

M

Mac OS keyboard shortcuts. See 
keyboard shortcuts, Mac OS

managing projects. See project 
management

margins, 93, 392
Mark In, 105, 188
Mark Out, 105, 188
markers

automated editing to, 139

Clip, 138
Encore chapter, 136
Flash cue point, 136
interactive, 138
Marker, 136
in multicamera editing, 234
overview of, 126–128
Prelude for, 138
Program Monitor and, 128–133
sequence, 136–137
Source vs. Program Monitor 

and, 129
starting, 128
Sync Lock and, 140–141
Track Lock and, 140
types of, 136–139
using, 135–139
Web link, 136

Marketplace & Exchange, 5
Master controls, 350–351
master copies, 433–435
Master Levels controls, 351
Master track output, 248
Match Sequence Settings, 433–434
Matte Cleanup setting, 370–371
Matte Generation setting, 370
mattes

defined, 364
generating, 370
introduction to, 371–372
Title tool for custom, 374–376
Track Matte Key effect, 373
traveling, 376–377
using graphics/other clips, 373

Maximum Bit Depth, 39
Maximum Render Quality

in exporting, 440
for master copies, 434
in project setups, 39

Media Browser
asset location with, 56–58
importing media with, 52–56
introduction to, 18
keyboard shortcut for, 52
tapeless workflows in, 54–55
video file types in, 55
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Media Encoder
adding stand-alone files in, 442
After Effects projects in, 442
Export Settings in, 439
exporting with, 430
file formats in, 436–438
importing projects directly 

in, 442
introduction to, 13–14, 435
modifying items in, 442
modifying presets in, 442
organizing media in, 91
Output panels in, 440
queueing exports in, 440–441
Source Range in, 440
Watch Folders in, 442

Media Files Are Deleted, 420
Media Files Remain on Disk, 420
menus, DVD 13–17
Mercury Playback Engine

GPU Acceleration in, 29–31
introduction to, 12
resolution control in, 133
Software Only version of, 30
video cards supported by, 301

Mercury Transmit, 34
metadata

displaying, 87
in Filter Bin Content, 80
in List View, 84
in organizing media, generally, 

76–77
Metadata Display panel, 87
Metadata Export panel, 441
Metadata panel, 90
Method option, 123
Microsoft AVI files, 437
Midtones Balance controls, 349–350
Midtones controls, 350–351
Milliseconds mode, 33
Mix controls, 275
Mix parameter, 272
modifier keys, 200
modifying presets, 442
monitoring audio, 252

monitoring footage, 91–95
monitors, 95, 104
mono, 248, 251, 254
Motion effect

adjusting, 206–211
anchor points in, 214–215
Auto Bezier interpolation 

and, 219
Bezier interpolation and, 219
clip positions in, 211–213
Continuous Bezier interpolation 

and, 219
Ease options in, 220–222
fixed effects in, 298
Hold interpolation and, 219
keyframe interpolation and, 

218–222
linear interpolation and, 218
other motion-related effects vs. 

See motion-related effects
overview of, 204–205
properties in, 209–211
reusing settings in, 213
review of, 229
Rotation property in, 214–215
settings in, 207–209
size of items in, 216–217
spatial interpolation and, 218
starting, 206
temporal interpolation and, 218

motion menus, DVD 7
motion-related effects. See also 

Motion effect
Basic 3D, 227–228
Bevel Edges, 224–225
Drop Shadow, 222–223
introduction to, 222
review of, 229
Transform, 225–227

mouse editing, 133
moving clips, 144–146
MP3 files, 436
MPEG files, 64
MPEG2 Blu-ray files, 436, 438
MPEG2-DVD files, 436, 438
MPEG2 files, 436, 438

MPEG4 files, 437
Multi-Camera Monitor, 241
multicamera editing

adding to source sequences in, 
236–237

angles in, 241
audio tracks in, 242
creating sequences in, 234–238
creating target sequences in, 

237–238
finalizing, 240
introduction to, 12
overview of, 230–231
process of, 233
re-recording edits in, 240
recording edits in, 238–239
review of, 243
source sequences in, 233
starting, 232
switching multiple cameras in, 

238–240
sync points in, 234–235
target sequences in, 233, 237–238
Timeline in, 241
tips for, 242
track targeting in, 238
uses of, 232

multichannel audio, 248
multiple video clips, 159–161
multithreading, 31
musical performances, 232
MXF OP1a files, 437

N

names, 87
nested sequences, 185–187
network-based storage, 35
New Project, 27–28
New Title keyboard shortcuts, 

393, 403
NLE (nonlinear editing), 10–11, 154
noise reduction, 286–292
nonlinear editing (NLE), 10–11, 154
normalizing audio, 257–259
Notch effect, 287
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O

Off mode, 265
offline clips, 419–420
OMF (Open Media Framework), 

443–444
once-in-a-lifetime events, 232
online clips, 419
opacity, defined, 363
Opacity effect, 298, 364–366
Open CL, 31
Open Media Framework (OMF), 

443–444
optimizing performance, 2–3
Option keys. See keyboard shortcuts, 

Mac OS
Ordering option, 123
organizing media

asset location in, 79
audio channel adjustment in, 

96–97
bins for, 82–89
clip modification in, 96–98
content analysis for, 89–91
face detection for, 91
Filter Bin in, 80
Find option in, 81
interpreting footage in, 97
labels for, 86–87
monitor customization for, 95
monitoring footage for, 91–95
names in, 87
overview of, 74–75
playback controls in, 94–95
Project panel for, 76–81
RED files in, 97–98
Reveal function for, 84
review of, 99
script attachment in, 89
speech analysis for, 89–90
starting, 76
transcript attachment in, 89
views in, 84–86

Out points, 188
Out Shift counter, 197
Output controls, 349
Output Levels controls, 349

Output panels, 440
overexposed images, 346
Overwrite edits

extracting/deleting segments in, 
146–148

introduction to, 105
moving clips in, 144
In and Out points in, 119
Program Monitor for, 129–131

overwrite trims, 188

P

P2 Movie format, 437
Pan controls, 264
Panner controls, 254
paragraph text

alignment of, 391
in bounding boxes, 393
in titles, 395–396

parameters, 161–163
parametric EQ (equalization), 

278–279
Paste clips keyboard shortcuts, 146
pause (K keys), 92, 201
paused resolution, 134–135
Pedestal controls, 343
Pen tool, 261
Perspective method, 319
phase of audio editing, 253
Photoshop

blending in, 363
copying files from, 83–84
flattened files from, 58–59
importing images from, 58–60, 79
introduction to, 14–15
layered files from, 59–60
Media Browser and, 54
menu modification in, DVD 17
title creation in, 13, 400–401

pick whips, DVD 16
pitch, 176
PitchShifter effect, 272–273
pixel aspect ratios, 97
pixel-based graphics, 61
Placement option, 123
play backward (J keys), 92

play forward (L keys), 92
playback

controls, 94–95
resolution, 93, 134
settings, 28–31

PNG files, 437
point text, 391–395
Position property, 207–210
Pre Delay controls, 275
preferences, 22
Prelude. See Adobe Prelude CS6
Premiere Pro. See Adobe Premiere 

Pro CS6
preprocessing footage, 368–369
prerequisites, 2
Preroll x frames, 448
presets

defined, 26
selection of, 37
for video effects, 315–317

previewing DVDs, DVD 17–18
Previews, 441
primary color correction, 348–351
primary colors, 335
Program Monitor

adding to Timeline with, 130
for clips, 128–133
content selection in, 131
controls in, generally, 128–130
dynamic trimming in, 200–201
Insert editing with, 131–133
introduction to, 18
keyboard shortcuts in, 202
modifier keys in, 200
paused resolution in, 134–135
playback resolution in, 134
resolution control in, 133–135
trim method selection in, 

198–200
Trim mode in, 196–198

project-based storage, 34
project management

collaboration and, 425
collecting files in, 423
copying files in, 423
Dynamic Link for, 426
final steps in, 424
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hard drives in, 425–426
importing projects/sequences 

and, 424
making clips offline in, 419–420
overview of, 416–418
Project Manager for, 421–423
Project menu for, 419–420
removing files in, 426
review of, 427
starting, 418
for trimmed projects, 422–423

Project Manager, 12, 421–423
Project menu, 419–420
Project panel

asset location in, 79
customizing, 78
Filter Bin in, 80
Find option in, 81
for organizing media, generally, 

76–78
project setups

Avid Media Composer projects 
in, 44–45

Capture Format settings in, 
33–34

creating new projects, 27–28
DV capture in, 33
Final Cut Pro projects in, 43
HDV capture in, 33
overview of, 24–25
playback settings in, 28–31
rendering settings in, 28–31
review of, 46
Scratch Disks settings in, 34–35
Sequence Presets tab in, 36–37
sequence setups in, 36–42
sequences matching sources 

in, 45
Settings tab in, 38–40
starting, generally, 26
third-party hardware capture 

in, 34
Tracks tab in, 40–42
video-audio display formats in, 

32–33
Projects panel, 18, 21
.prproj files, 16

Q

queueing exports, 440–441
Quicktime files, 437

R

R3D files, 97–98
rasterization, 61
Rate Stretch tool, 176–177
Razor tool, 143
re-recording multicam edits, 240
Read mode, 265
readability of text, 387
real-time playback, 28–29
rearrange clips keyboard 

shortcuts, 145
rearranging clips, 145
recording

to DV/HDV decks, 448
multicam edits, 233, 238–239, 240
scratch narration tracks, 62–63
to tape, 446–447

RED files, 97–98
red, green, blue, alpha (RGBA) 

values, 365
red, green, blue (RGB) Color 

Corrector, 343
red, green, blue (RGB) Curves effect, 

342–343
Reference Monitor

combination views in, 339
introduction to, 331
RGB parade in, 337
Vect/YC Wave/RGB parade 

in, 339
Vect/YC Wave/YCbCr parade 

in, 339
vectorscope in, 334–337
YC Waveform in, 332–334
Y'CbCr parade in, 338

regular trimming, 188–189, 196
relinking lesson files, 4
removal

of background noise, 290–292
of color, 341
of files, 426

Remove In and Out points 
(Alt+X), 115

Remove In point (Alt+I), 115
Remove Out point (Alt+O), 115
rendering

After Effects projects, 442
Maximum Render Quality for, 39, 

434, 440
settings for, 28–31

replacement
of clips, 180–183
of colors, 341
Replace Footage for, 183–184

resolution control, 133–135
resources, 4–5
result stabilization method, 319
retiming clips

changing speed/duration, 
174–180

downstream effects of, 180
introduction to, 174
Rate Stretch tool for, 176–177
time remapping for, 177–180

reusing Motion settings, 213
Reveal functions, 84
Reverb effect, 271, 274–275
RGB (red, green, blue) Color 

Corrector, 343
RGB (red, green, blue) Curves effect, 

342–343
RGB (red, green, blue) parade, 337
RGBA (red, green, blue, alpha) 

values, 365
Ripple Delete, 147
Ripple Edit tool, 164–165, 189–190
ripple trimming, 196
roll trimming, 196
Rolling Edit tool

for transitions, 162–163, 165
for trimming, 191–192

rolling shutter reduction effects, 
318–319

rolling text, 408–409
Rotation property, 207–211, 214–216
Roto Brush Tool, 378
RS-422 deck controls, 449
rubber bands, 261
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S

safe margins, 93, 392
Samples, 32
Saturation controls, 350
saving

custom title styles, 399
as legacy AAF, 444
presets, 316–317
titles, 387

Scale
option, 317
property, 207–209, 216–217
Width, 207

Scene headings, 88
Scratch Disks settings, 34–35
script attachments, 89
script writing, 88
scrubbing, 115, 118
SD (standard-definition) video, 333
SDI (Serial Digital Interface), 66, 449
secondary color correction, 348, 

350–353
secondary colors, 335
Select All keyboard shortcuts, 58, 

86, 122
Select audio or video clips 

shortcuts, 161
select Effects Browser (Shift+7), 299
Select items keyboard shortcuts, 53, 

83, 168, 242
selecting clips, 141–143
selecting ranges in clips, 105–107
Selection tool, 142
Separate Audio, 444
sequence 05 Noisy Reduction, 

286–288
sequences

in Avid Media Composer 
projects, 44–45

conforming, 111
creating to match sources, 45
defined, 26
exporting. See export options
Final Cut Pro projects and, 43
markers for, 136–137
in multicamera editing, 234–238

nested, 187
opening, 112
Presets tab for, 36–37
rearranging clips in, 145
Sequence Presets tab for, 36–37
setting up, 36–42
Settings tab for, 38–40
Tracks tab for, 40–42
transitions in, 160
trimming in, 188–189
in video editing, 110–112

Serial Digital Interface (SDI), 66, 449
Settings tab, 38–40
Setup controls, 333
Shadow tool, 398
Shadows Balance controls, 349–350
Shadows controls, 351–352
shapes, 402–404, 406–407
Sheen tool, 398
Shift keys. See keyboard shortcuts
shooting videos, 362–363
shots, defined, 119
Show Split View controls, 349
Silverlight, 438
single frames, 431–432
single-sided trims, 188
single-sided video transitions, 156
Size controls, 275
size of items, 216–217
Slide Edit tool, 192–193
Slip edits, 194–195
Small Caps option, 390
Smooth Motion, 319
Snap tool, 144
software-only mode, 12
Source Monitor

controls in, 105
creating subclips in, 108–109
customizing workspaces in, 

21–22
introduction to, 18, 101–102
loading multiple clips in, 104
loading single clips in, 102–103
monitors in, 104
paused resolution in, 134–135
playback resolution in, 134
Program Monitor vs., 129

resolution control in, 133–135
selecting ranges in clips in, 

105–107
trimming in, 188

Source Range, 440
source track indicators, 113
spatial interpolation, 218
special color effects, 353–355
special video effects, 232
spectacular highlights, 227–228
speech analysis, 89–90
Speech to Text feature, 90–91
speed keyframes, 178–179
speed of clips, 174–180
SpeedGrade. See Adobe 

SpeedGrade CS6
spelling, 396
Spiekermann, Erik, 387
Spill Suppression setting, 371
spills, 363
split audio edits, 259–260
splitting clips, 143
stand-alone files, 442
standard audio editing, 251
standard-definition (SD) video, 333
standard EQ (equalization), 275–278
Star Wars, 154
stereo, 248, 251, 254
still image duration, 122
Stop Stealing Sheep & Find Out How 

Type Works, 387
storage of video, 34
Story program, 88
storyboard editing, 121–124
streamlining projects, 421
striping tapes, 447
Stroke tool, 398
style of text, 387
stylizing text, 397–401
subclips, 108–109
submixes

applying effects to, 284–285
in audio tracks, 265
introduction to, 42
for sweetening sound, 282–284

Subspace Warp method, 319
Support, 5
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sweetening sound. See audio editing
switching multiple cameras, 238–240
Swivel property, 228
Sync Lock, 140–141
sync points, 233–235
system-based storage, 34–35

T

tail handles, 163–165
tail material, 154
talk show formats, 232
tapeless workflows, 54–55
Targa files, 437
target sequences, 237–238
targeting tracks, 113
technical color effects, 343
temporal compression, DVD 7
temporal interpolation, 218
text brightness, 22
text on a path option, 393
theatrical performances, 232
third-party hardware capture

as export options, 449
in project setups, 34
videotape, 66

three-point editing, 120, 172
Three-Way Color Corrector, 342, 349
thumbnails

organizing, 85–86, 92
in storyboard editing, 121

TIFF files, 437
tighter tracking, 390
Tilt property, 228
time remapping, 177–180, 298
time rulers, 115
timecodes

burn-in effects, 320–321
introduction to, 32
in multicamera editing, 234
for organizing media, 93
in video editing, 105–106

Timeline
adding clips to, 130
advanced editing techniques 

in, 177
angles in, 241

arranging clips in sequences 
in, 145

audio clip selection only, 143
chapter markers in, DVD 7–9
clip selection in, 141–143
clipboard in, 146
conforming sequences in, 111
customizing workspaces and, 21
deleting segments in, 146–148
disabling clips in, 148
dragging clips in, 144
duration of clips in, 175–180
extracting segments in, 146–147
four-point editing in, 173–174
gaps location in, 141–143
introduction to, 17
Lift in, 146
linking clips in, 143
moving clips in, 144–146
opening sequences in, 112
In and Out points in, 114–115
overview of, 109–110
ranges of clips in, 142
Ripple Delete in, 146–148
sequences in, 110–112
speed of clips in, 175–180
splitting clips in, 143
targeting tracks in, 113
time rulers in, 115
tracks in, 112–113
transitions in, 152
trimming in, 188–189
unlinking clips in, 143
video clip selection only, 143
for video editing, 109
video playback on, 29
Work Area in, 116

Tint effect, 340
Titler

aligning shapes/logos in, 406–407
aligning text in, 391
anchor points in, 404
crawling text in, 408–409
logos in, 405
point text in, 393–395
Rectangle tool in, 403
rolling text in, 408–409

safe margins in, 392
Show Video button in, 397
text creation in, 392–393
window of, 382–386

titles
After Effects for, 410–413
alignment of, 391
animated text in, 410–413
appearance of, 397–398
color choice in, 388
crawling text in, 408–409
creating, 392–396
design of, 13
font choice in, 387
kerning in, 389
leading in, 391
logos in, 402, 405–407
overview of, 380–381
paragraph text in, 395–396
Photoshop for, 400–401
point text in, 393–395
review of, 414
rolling text in, 408–409
safe margins in, 392
safe zones for, 94, 392
saving custom styles of, 399
saving for reuse, 387
shapes in, 402–404, 406–407
starting, 382
stylizing text in, 397–401
Title tool for, 374–376
Titler for. See Titler
tracking in, 390
video typography in, 387

toggle between screens  
(Shift+` [grave]), 103

Tonal Range Definition, 350
Tools panel, 19
Touch mode, 266
touring interfaces, 16
Track Lock, 140
Track Matte Key effect, 373
track patching, 131–132
Track Select tool, 142
track targeting, 238
track vs. clip keyframes, 262–263
tracking titles, 390
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tracks
defined, 11
introduction to, 18
in video editing, 112–113

Tracks tab, 40–42
transcript attachments, 89
Transform effect, 210, 225–227
transitions

adding audio, 166–168
adding video, generally, 155–161
applying audio, 167–168
applying to multiple video clips, 

159–161
A/B mode for, 161–165
best practices with, 153–154
changing parameters of, 161–163
crossfades, 166–167
defined, 152–153
edit points for, 154–155
Effect Controls panel for, 

161–163
fine-tuning video, 161–165
handles for, 154–155, 163–165
head handles for, 163–165
overview of, 150–151
review of, 169
in sequences, 160
single-sided video, 156
starting, 152
tail handles for, 163–165
between video clips, 157–158
when to use, 153

Transitions option, 123
traveling mattes, 376–377
Treble effect, 271, 273–274
trial version, 2
Trim Backward, 197, 202
Trim Backward Many, 197, 202
Trim Forward, 197, 202
Trim Forward Many, 197
Trim mode keyboard shortcuts, 

199–200
trimmed projects, 422–423
trimming

advanced, 189–195
defined, 162

dynamic, 200–201
introduction to, 13
keyboard shortcuts for, 199–202
In and Out points in, 188
in Program Monitor, 195–202
regular, 188–189, 196
ripple, 196
Ripple Edit tool for, 189–190
roll, 196
Rolling Edit tool for, 191–192
in sequences, 188–189
Slide Edit tool for, 192–193
Slip edits for, 194–195
in Source Monitor, 188
in Timeline panel, 188–189

TV, 5
tweening, 218, 311
type on pattern issues, 388
Typographic Properties panel, 397

U

Ultra Key effect, 369–371
Uncompressed Microsoft AVI 

files, 437
underexposed images, 345
Undo Edit keyboard shortcuts, 123, 

141, 175
unlinking clips, 143
updates, 6
Use Frame Blending, 441
Use Maximum Render Quality, 440
Use Previews, 441
user-generated video sites, 438

V

Vect/YC Wave/RGB parade, 339
Vect/YC Wave/YCbCr parade, 339
vector graphics, 405
vectorscope, 334–337
velocity, 313–315
video-audio display format settings, 

32–33
video cards, 34–35, 301
Video Cross Dissolve, 168
Video Delimiter effect, 343
Video Display Format, 32

video editing
adding transitions. See transitions
assembly edits, 122
commands for, 116–124
conforming sequences in, 111
content selection in, 131
controls in, 105
creating subclips in, 108–109
for DVD and Blu-ray discs, 

DVD:7
effects in. See video effects
four-point editing, 120
insert edits, 116–118
keyboard shortcuts for, 109
loading multiple clips in, 104
loading single clips in, 102–103
markers in. See markers
monitors in, 104
opening sequences in, 112
In and Out points in, 114–115
overview of, 100–101
overwrite edits, 119
Program Monitor for, 128–133
ranges in clips for, 105–107
resolution control in, 133–135
review of, 125
sequences in, 110–112
Source Monitor for, 101–109, 129
starting, 101
still image duration in, 122
storyboard editing, 121–124
targeting tracks in, 113
three-point editing, 120
time rulers in, 115
Timeline panel for, 109
tracks in, 112–113
transitions in. See transitions
Work Area in, 116

video effects
32-bit color, 301
accelerated, 301
adjustment layers in, 304–307
After Effects for, 308–310
applying, 302–304
Black & White effect, 302
built-in presets for, 315–316
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in editing videos. See video 
editing

Effects Browser for, 299–300
fixed, 297–299
frequently used, 318?
image stabilization, 318–319
keyframing, 311–315
lighting, 321–323
Motion effect, 298
Opacity effect, 298
overview of, 294–295
presets for, 315–317
review of, 324
rolling shutter reduction, 

318–319
saving presets for, 316–317
starting, 296
Time remapping effect, 298
Timecode burn-in, 320–321
Volume effect, 298
Warp Stabilizer, 318–319
working with, generally, 296?
YUV, 301

video file types, 40, 55
Video Input/Output devices, 449
video scope essentials, 330
video sites, 438
Video tab, 440
video typography, 387
videotape

batch capture for, 69–72
entire tapes, 67–69
generally, 66
scene detection in, 72
third-party hardware in, 66

viewing audio samples, 250

views, 84–86
Vimeo, 438
Virtual Studio Technology (VST) 

plug-ins, 11
visual effects, 232
volume adjustments

audio tracks, 254–255
in Effects Controls panel, 254
gain vs., 257
keyframing, 261
smoothing between 

keyframes, 262
Volume effect, 298
volume faders, 264
volume unit (VU) meters, 281
VST (Virtual Studio Technology) 

plug-ins, 11
VU (volume unit) meters, 281

W

Warp Stabilizer effect, 318–319
Watch Folders, 442
Waveform Audio files, 437
Web link markers, 136
Welcome screen, 27
White Balance controls, 347–348
Windows

Bitmap files in, 437
keyboard shortcuts for. See 

keyboard shortcuts, 
Windows

Media files in, 437
work areas, 30, 116
workflows

color-oriented, 328–329
enhancing, 12–13

expansion of, 13
file-based, 54
incorporating components in, 

13–14
introduction to, 11
tapeless, 54–55

workspaces
for audio editing, 247
for color correction, 329
customizing, 19–22
defined, 16
layout of, 17–19

wrappers, 40
Write mode, 266

X

x and y values, 211
XLR audio, 449
XML files, 43
XMP, 12

Y

Y (luminance), 332
y values, 211
YC Waveform, 332–334
Y'CbCr parade, 338
YouTube, 438
YUV effects, 301

Z

z-axis, 214
zoom bars, 115
Zoom controls, 84–85, 93
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